
RAILER RED V60 User Manual 





 

Table Of Contents 

RAILER RED Help ................................................................................................1 

Basics................................................................................................................1 

Introduction ....................................................................................................1 

Opening a RAILER RED Database ...............................................................1 

RAILER RED Modes .....................................................................................2 

RAILER RED Menu .......................................................................................2 

RAILER RED Toolbar ....................................................................................3 

Inventory ...........................................................................................................3 

Network Inventory..........................................................................................3 

Inspection..........................................................................................................6 

Inspection Impaired .....................................................................................13 

Support............................................................................................................17 

Support Center ............................................................................................17 

Software Development ................................................................................17 

Acknowledgements......................................................................................18 

Disclaimer ....................................................................................................19 

iii 





 

RAILER RED Help 

Basics 
Introduction 

Welcome to RAILER Remote Entry Database (RED) Version 6.0.  RAILER RED 
is the portable field collection application for use with the RAILER version 6.0 
Sustainment Management System (SMS) Enterprise Application.  RAILER RED 
allows inspectors to collect the necessary inventory and inspection information 
about their track network electronically on a laptop or tablet PC for automatic 
upload into the RAILER system.  This saves the effort of collecting field data on 
paper, and then entering that data into the RAILER system at a later time.  In 
addition to time and cost savings, the RAILER RED data entry process improves 
the accuracy of the data collected. 

RAILER RED can be used both in the initial implementation of the RAILER SMS 
Process for collecting inventory and inspection information, as well as in 
continued re-inspections and inventory updates. 

 

Opening a RAILER RED Database 

Before using the RAILER RED program, track information has to be exported 
from the RAILER SMS Program.  This results in a database of track information 
that the RAILER RED program can open to display to the user.  Refer to the 
RAILER online help contents for step by step instructions on creating this 
RAILER RED export database. 

Once the database is exported and created, it can be transferred to the computer 
running RAILER RED.  Then on the RAILER RED menu, chose File -> Open 
and the following window appears: 
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Select the RAILER RED database that was created in the export from RAILER, 
and chose Open.  The database will be open. 

RAILER RED Modes 

There are two distinct operating environments in RAILER RED:  Inventory Mode 
and Inspection Mode.  When the program is first opened, it always defaults to 
inventory mode.  This allows the user to view, input, and edit inventory related 
information about the tracks. 

Clicking the  button toggles the RAILER RED program to Inspection Mode. 
 Here, the user can view, input, and edit inspection information for each track or 
track segment.  When the user first enters inspection mode, they will be 
prompted to provide the inspector name, which can be a new or existing 
inspector.  After that, all inspection entered into the system will be saved with that 

inspector name.  Clicking the   button toggles the user back to the 
inventory mode of the program.  

RAILER RED Menu 
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RAILER RED has the following menu: 
• File:  Commands for opening a database, viewing database info, and 

exiting the program 
• Tools:  Commands for changing the inspector, and performing Safety 

Inspections 
• Help:  Commands for accessing the RAILER RED help contents 

 

RAILER RED Toolbar 

RAILER RED has the following toolbar buttons: 
• Insp/Inv:  Toggles the program between Inspection and Inventory modes 
• New:  Creates a new record 
• Edit:  Click to edit an existing record 
• Delete:  Click to delete the currently selected record 
• Copy:  Click to copy the currently selected record 
• Comments:  Allows users to put in additional explanatory comments about 

a record 
• Save:  When the user is adding or editing a record, this saves the addition 

or edits 
• Cancel:  When the user is adding or editing a record, the closes the record 

without saving the addition or edits 
• List:  When in inspection model, this button brings up a list of inventory 

items to be inspected and/or past inspection defects for the track or 
segment 

• W.O. Items:  When in inspection mode for ties or turnouts, this button 
allows the user to input the location of a tie/turnout defect, as well as 
change condition level or denote a work order 

 

 

Inventory 
Network Inventory 

When the RAILER database is exported to RAILER RED, it will display the tracks 
and track segments that have been exported from RAILER.  It is recommended 
that all tracks and segments be set up in RAILER prior to exporting to RAILER 
RED for inventory and inspection data collection.  Those track will then be 
displayed on the inventory tree on the left as in the figure below.  If a track has 
multiple segments, clicking the plus [+] sign next to the track displays those 
segments.  Note that while the program allows the user to select and highlight 
both tracks and segments in inventory mode, it will only allow the user to add or 
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edit inventory records when the track is selected.  This is because inventory 
information is associated with each track, not its individual segments. 

While in RAILER RED, additional tracks can be added and segments created by 
selecting the Identification tab and clicking the New toolbar button.  This tab also 
allows the user to view and edit track and segment attribute information. 

 

 

Track Inventory 

After the tracks and/or segments have been entered, the user can begin adding 
the inventory items associated with the track.  These inventory items consist of 
the following and have a separate tab in the inventory mode for each: 

• Structure:  Information about the rail weight, section, length, Tie Size and 
Material, Ballast Type, Hold Down Devices, Tie Plates, etc, including 
where each structure change begins 

• Appliances:  Records about the type and location of track appliances such 
as derails, wheel stops, and car bumpers 

• Turnouts:  Records about the type and location, and other attribute data 
about turnouts 

• Curves:  Records about the boundary locations and geometry for curves 
• Bridges:  Records about the location and type of railroad bridges 
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• Grade:  Records about the boundary locations and % of horizontal grades 
• Grade Crossings:  Records about the location, type, and material for 

vehicle grade crossings 
• Rail Crossings:  Records about the location and type of rail crossings 
• Restrictions:  Records about track restrictions and clearance issues 
• Drainage:  Records about the location and type of drain items such as 

culverts, pipes and ditches. 
When inputting inventory information, the user will highlight on the tree which 
track they are on.  All inventory records will be associated with the highlighted 
track.  Note: Inventory is conducted at the Track level. No inventory items can be 
entered or edited at the Segment level. At the Segment level, inventory is Read-
Only.  The user can then enter a new inventory record by selecting the 
appropriate tab, and clicking the New button. 
 

 
 
After multiple inventory items for a given tab have been created, the user can use 
the < and > buttons to scroll through the records.  When an inventory record is 
displayed as the active record, the user can edit, delete, or copy that existing 
record.  The copy feature is an efficient tool to use when many inventory records 
are nearly identical, and the use only has to change a field or two, versus 
entering all the field in each time. 
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Inspection 
Detailed Inspection 

The Detailed Inspection mode in RAILER RED allows the user to record track 
related defects to be uploaded and stored by the RAILER SMS system.  These 
defects are used to determine condition levels and standard operating 
restrictions for the track network.  Track inspection always occurs at the segment 
level, so if a track has multiple segments, an individual segment has to be 
selected.  All recorded defects are associated with that segment that is 
highlighted in the tree.  If a track is not segmented, the user may select the track 
itself to record inspection defects. 

General Detailed Inspection Information 

When the user first enters the inspection mode, it prompts for the inspector's 
name.  All inspection records entered will then be tagged with that name.  To 
change the inspector, the user can go to the Tools menu and chose 
Inspectors... 

The program also internally appends the inspection date to each inspection 
record automatically, to keep a record of when each track or segment was last 
inspected.  When a users enters a new inspection, that inspection record 
remains the active current inspection for period of 30 days after the initial 
inspection date.  During this time, all defects associated with this current 
inspection can be viewed, edited, and updated.  After this 30 day period, 
however, the inspection record becomes "historic" and are no longer displayed 
for the current view.  Instead, any defects that are added are associated with a 
new inspection record. 

When a defect is entered, the program automatically determines the condition 
standard that is applicable based on the governing track standard that is set in 
the RAILER database.  This will be displayed to the user on the screen, and if a 
situation warrants a lowering of the standard, the inspector can manually edit this 
field from the drop list.  Most defects recorded also require a quantity to be 
entered.  this is used to determine the extent of the defect adversely affecting the 
track.  A quantity can be entered in directly to the Quantity field.  Alternatively, 
the length and density of track inspected can be entered, and the program will 
calculate the quantity using this information.  Note that when entering a defect 
that affects a length of track, the Station location denotes the beginning of where 
that defect occurs. 

Finally, if a segment has a component, such as ties, rail, ballast, etc., that is 
defect free (ie. there are no identified defects) the inspector should check the 
Defect Free box in the upper right hand corner to denote that the segment was 
inspected. 
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Tie Inspection 

The Ties tab is used to keep a tally of tie defects.  This keeps track of both single 
and defective tie clusters, as well as joint tie defects.  In addition, the Other 
Defects button allows the user to record missing and improperly positioned 
(Skewed) ties.  The total field in the upper right keeps a tally of total defective 
ties. 

 

Rail, F&OTM, and Ballast Inspection 

For these tabs, the user simply clicks Add to add a new defect, enters the 
station, chooses the defect from the list, and enters the affected rail side and 
quantity.  If common defects repeat, the inspector can use the Copy button to 
copy an existing defect, then change only the fields that have changes, such as 
station location. 
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Appliance, Rail Crossing, and Drainage Inspection 

For these tabs, the user clicks Add to add a new defect, then clicks the list button 
to chose which piece of track inventory the defect is associated with.  This list is 
based on the items (appliances, drainage, or rail crossings) that have been 
recorded for that track's inventory. 
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Grade Crossing Inspection 

Under the Grade Crossing tab, the user clicks Add to add a defect, then the List 
button to select which grade crossing from the inventory.  The inspector can then 
enter information on crossing defects, flangeway measurements, and General 
Observations. 
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Turnout Inspection 

Under the Turnout tab, the user clicks the Add button, then chooses the turnout 
to be inspected.  The inspector can then enter information about general 
observations, switch tie defects, specific components (switch, frog, and 
guardrail), and measurements.  When entering measurements, a pop-up box is 
displayed to record the value in 1/8" increments. 
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Under the Turnout specific components inspection, the inspector chooses which 
turnout component to inspect (switch, frog, or guardrail) and then clicks the New 
button to add a row and chose the defect from the list. 
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Manual Track Geometry Inspection 

Under the Manual track geometry tab, the user can enter information about track 
geometry deviations, such as Alignment, Crosslevel, Gauge, Profile, and Rail 
Displacement.  The user clicks the Add button, enters the station, rail, 
measurement, and affect length information. 
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Inspection Impaired 

On certain occasions, it may not be possible to adequately and completely 
inspect a portion of track due to the present of cars, excessive ballast on track, or 
getting into controlled areas.  In these circumstances, the inspector can denote 
this using the inspection impaired tab. 
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Previous Inspection List 

When inspecting a segment in RAILER RED, the inspector may come across 
several inventory items as they walk down the track that require an inspection. 
 This includes such items as drainage culverts, appliances, turnouts, and grade 
crossings.  The inspection list gives the inspector a sorted list in increasing 
station location of these inventory items.  The inspector can move down this list 
line by line, select the next item to be inspected, and then click the Inspect 
button to go directly to that inspection record to inspect that item.  This feature 
saves times and ensures that all inventory receives and inspection. 
 
When past inspection information has been recorded and exported for a 
segment, those defects from the most recent inspection can also be viewed in 
the Inspection List.  Again, all defects are presented in increasing station order, 
and the inspector can move down the list and verify if the defect has been fixed 
or still exists.  If it still exists, they can click the Copy button to directly copy that 
defect into the current inspection record, thus saving and inspection effort. 
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Safety Inspection 

Unlike a detail inspection which addressed all defects, a safety inspection usually 
only addresses the most critical defects types which should be corrected in an 
expedient fashion.  Safety inspection information, as with all inspection 
information, is stored and accessed at a segment level.  To access the safety 
inspection screen, go to the Tools menu and chose Safety Inspection.  The 
Safety Inspection screen contains a grid, with each row of the grid representing 
safety defects for that segment. 
 

 
 
To insert additional safety defects, click the Insert button to insert additional rows 
to the grid.  To delete a safety defect from the segment record, highlight the row, 
and click the Delete button.  The safety grid shows all defects previously 
recorded, regardless of the date they were found.  Use the Show Existing 
Defects check box to display only current safety defects that exist on the track.   
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Safety Inspection may occur on a monthly, or more frequent, schedule.  If safety 
defects have been identified via a previous inspection, and those defects are still 
found to be present under the next safety inspection, it is not necessary to enter 
those defects again - the system already has those recorded as existing defects. 
 If a safety inspection is performed that turns up no new safety defects, a new 
record should be entered for that inspection date where the component is set to 
None - denoting no defects. 
 
During a detailed inspection, it is not unlikely to come across a critical defect that 
requires a immediate work action because it is a safety concern.  If a given 
defect is denoted as requiring a work order during the detailed inspection, that 
defect will be displayed on the safety screen as well. 

 

Work Orders 

During an inspection, the inspector may come across a defect that requires 
attention immediately.  In this case, the inspector would denote that by checking 
the W.O. Required checkbox for that defect.  Checking the work order box 
automatically makes the defect a safety defect to be included on the safety 
screen.   
 
To create a work order for a tie defect or a turnout defect, the inspector must first 
enter the defect on the detailed inspection screen then save the record.  Then, 
the inspector clicks the Edit button to edit the record again, and then choses the 
W.O. Items button on the tool bar.  This brings up a screen similar to the one 
below. 
 

 
 
The inspector can chose the defect from the list to associate a work order with, 
optionally enter the location of the defect, and click the W.O. Req'd box. 
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Support 
Support Center 

University of Illinois 
 
If RAILER software was obtained from the University of Illinois, contact the 
following for software support: 

Scott McDonald 
Tel: (800)895-9345 
Email: techctr@uiuc.edu 
University of Illinois Technical Support Center 
302 East John Street, Suite 302 
Champaign, IL 61820 

 
 

SMS Center of Expertise for RAILER 
 
The SMS Center of Expertise for Builder was created to provide a full range of 
customer support to DoD RAILER users. Services include: 

• Support for implementation of RAILER 
• Support for Inspection and re-inspection of Railroad track 
• Condition assessment analysis 
• Technical support for RAILER users 
• Training 
• Development of annual and long range work plans 
• Budget forecasting and justification 
• Development of GIS applications and presentations 
• Database maintenance 
• Software customization for specific organization requirements 

The SMS POC for RAILER implementation is: 
Michael Grussing, P.E. 
Civil Engineer/Principle Investigator 
US Army Corps of Engineers, 
Engineer Research and Development Center, 
Construction Engineering Research Laboratory 
P.O. Box 9005 
Champaign, IL 61826-9005 
Phone: 217.398.5307 
Email: michael.n.grussing@erdc.usace.army.mil 

Software Development 
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Engineer Research and Development Center - Construction 
Engineering Research Labs (ERDC-CERL) 
 
The Principles on RAILER development are: 

Michael Grussing, P.E. 
Civil Engineer/Principle Investigator 
US Army Corps of Engineers, 
Engineer Research and Development Center, 
Construction Engineering Research Laboratory 
P.O. Box 9005 
Champaign, IL 61826-9005 
Phone: 217.398.5307 
Email: michael.n.grussing@erdc.usace.army.mil 

 
 
Lance Marrano 

System Engineer/Project Manager 
US Army Corps of Engineers, 
Engineer Research and Development Center, 
Construction Engineering Research Laboratory 
P.O. Box 9005 
Champaign, IL 61826-9005 
Phone: 217.373.4465 
Email: lance.r.marrano@erdc.usace.army.mil 
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Disclaimer 

This program is furnished by the U.S. Army Corps of Engineers Engineering 
Research and Development Center - Construction Engineering Research 
Laboratory (ERDC-CERL) and is accepted and used by the recipient with the 
express understanding that the United States Government, the U.S. Army Corps 
of Engineers, and ERDC-CERL make no warranties, expressed or implied, 
concerning the accuracy, completeness, reliability, usability, or suitability for any 
particular purpose of the information and data contained in this program or 
furnished in connection therewith, and the United States shall be under no 
liability whatsoever to any person by reason of any use made thereof. This 
program is a property of the ERDC-CERL. The recipient agrees not to assert any 
proprietary rights therein or to represent this program to anyone as other than a 
government property; furthermore, this program can only be copied for legitimate 
backup purposes by the user. 
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